
Blue Pumpkin Integration 7.1

Deployment Guide



The information contained herein is proprietary and confidential and cannot be disclosed or duplicated 
without the prior written consent of Genesys Telecommunications Laboratories, Inc.

Copyright © 2004–2007 Genesys Telecommunications Laboratories, Inc. All rights reserved.

About Genesys
Genesys Telecommunications Laboratories, Inc., a subsidiary of Alcatel, is 100% focused on software for call centers.  
Genesys recognizes that better interactions drive better business and build company reputations. Customer service 
solutions from Genesys deliver on this promise for Global 2000 enterprises, government organizations, and 
telecommunications service providers across 80 countries, directing more than 100 million customer interactions every 
day. Sophisticated routing and reporting across voice, e-mail, and Web channels ensure that customers are quickly 
connected to the best available resource—the first time. Genesys offers solutions for customer service, help desks, 
order desks, collections, outbound telesales and service, and workforce management. Visit www.genesyslab.com for 
more information.
Each product has its own documentation for online viewing at the Genesys Technical Support website or on the 
Documentation Library CD, which is available from Genesys upon request. For more information, contact your sales 
representative.

Notice
Although reasonable effort is made to ensure that the information in this document is complete and accurate at the 
time of release, Genesys Telecommunications Laboratories, Inc., cannot assume responsibility for any existing errors. 
Changes and/or corrections to the information contained in this document may be incorporated in future versions.

Your Responsibility for Your System’s Security
You are responsible for the security of your system. Product administration to prevent unauthorized use is your 
responsibility. Your system administrator should read all documents provided with this product to fully understand the 
features available that reduce your risk of incurring charges for unlicensed use of Genesys products.

Trademarks
Genesys, the Genesys logo, and T-Server are registered trademarks of Genesys Telecommunications Laboratories, 
Inc. All other trademarks and trade names referred to in this document are the property of other companies.

Technical Support from VARs
If you have purchased support from a value-added reseller (VAR), please contact the VAR for technical support. 

Technical Support from Genesys
If you have purchased support directly from Genesys, please contact Genesys Technical Support at the following 
regional numbers:

Prior to contacting technical support, please refer to the Genesys Technical Support Guide for complete 
contact information and procedures.

Ordering and Licensing Information
Complete information on ordering and licensing Genesys products can be found in the Genesys 7 Licensing Guide.

Released by
Genesys Telecommunications Laboratories, Inc. www.genesyslab.com
Document Version: 71int_dep_bpi_04-2007_v7.1.001.04

Region Telephone E-Mail

North and Latin America +888-369-5555 or +506-694-6767 support@genesyslab.com

Europe, Middle East, and Africa +44 (0) 118 974 7002 support@genesyslab.co.uk

Asia Pacific +61 7 3368 6868 support@genesyslab.com.au

Japan +81-3-5649-6821 support@genesyslab.co.jp

http://www.genesyslab.com
http://genesyslab.com/support/kb/browse/Default.asp?type=1&fmly=158&suit=0&show=item&item=8BCF0D6945317D39754186C5094C92B9
mailto:support@genesyslab.co.uk
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A1D12650&view=item
mailto:support@genesyslab.com.au
support@genesyslab.com
http://www.genesyslab.com
support@genesyslab.co.uk
support@genesyslab.com.au
support@genesyslab.co.jp


Deployment Guide 3

Table of Contents
Chapter 1 About This Document ............................................................................  5

Intended Audience..................................................................................... 5
Chapter Summaries................................................................................... 6
Document Conventions ............................................................................. 6
Related Resources.................................................................................... 8
Making Comments on This Document ...................................................... 9

Chapter 2 Overview of the Blue Pumpkin Integration ........................................  11

Overview.................................................................................................. 11
Historical Data .................................................................................... 12
Real-Time Agent States ...................................................................... 12
Planning Objects................................................................................. 13

Architecture ............................................................................................. 14
Historical Statistics Data Flow............................................................. 15
Real-Time Agent State Data Flow....................................................... 15

Planning Your Deployment ...................................................................... 16
Historical Statistics.............................................................................. 17

Chapter 3 Configuration and Installation.............................................................  19

Overview.................................................................................................. 19
Preliminary Preparation ........................................................................... 20
Import the Application Templates ............................................................ 20

Import the BPI Solution Template ....................................................... 21
Install the Configuration Wizards............................................................. 21
Run the Configuration Wizards................................................................ 22

Configuring WFM Data Aggregator .................................................... 23
Configure the Statistics Configuration Utility Application Object ......... 24

Install the Components............................................................................ 25
Install WFM Data Aggregator.............................................................. 25
Install Blue Pumpkin Integration ......................................................... 25
Install the Statistics Configuration Utility ............................................. 26

Configure Application Objects Manually.................................................. 26
Manually Create the BPI Solution Object ........................................... 27



Table of Contents

4 Blue Pumpkin Integration 7.1

Options Tab Settings for WFM Data Aggregator................................. 28

Chapter 4 Starting and Stopping ..........................................................................  37

Overview.................................................................................................. 37
Start and Stop BPI with SCI..................................................................... 38
Start and Stop the Servers....................................................................... 39

Configure the Windows Services........................................................ 39
Manually Start a Windows Service...................................................... 39
Start the BPI Servers Manually ........................................................... 39
Stop the BPI Servers .......................................................................... 40
Stop the Servers Manually.................................................................. 40
Stop a Server’s Windows Service....................................................... 40

Start and Stop the Statistics Configuration Utility..................................... 41
Stop the Statistics Configuration Utility ............................................... 41

Index .................................................................................................................  43



Deployment Guide 5

Chapter

1 About This Document
Welcome to the Blue Pumpkin Integration 7.1 Deployment Guide. This 
document:
• Provides a high-level overview of the product.
• Presents deployment-planning considerations.
• Tells you how to install and configure the product.
• Explains how to start and stop the product’s components.
This document is valid only for the 7.1.0 release(s) of this product. 
This chapter provides an overview of this document, identifies the primary 
audience, introduces document conventions, and lists related reference 
information: 

Intended Audience, page 5
Chapter Summaries, page 6
Document Conventions, page 6
Related Resources, page 8
Making Comments on This Document, page 9

The Blue Pumpkin Integration (BPI) enables you to gather real-time agent 
status and historical performance data from the Genesys Customer Interaction 
Management Platform and feed it to the Blue Pumpkin workforce management 
product. This enables you to access high-quality statistical data that the 
Genesys platform provides.

Intended Audience
This document, primarily intended for contact center managers and system 
administrators, assumes that you have a basic understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
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• Network design and operation.
• Your own network configurations.
You should also be familiar with:
• Genesys Framework architecture and functions.
• Blue Pumpkin architecture and functions.

Chapter Summaries
In addition to this opening chapter, this document contains these chapters: 
• Chapter 2, “Overview of the Blue Pumpkin Integration,” on page 11 

introduces the Blue Pumpkin Integration product, explains its architecture, 
and offers deployment-planning considerations.

• Chapter 3, “Configuration and Installation,” on page 19 describes how to 
configure and install the product. 

• Chapter 4, “Starting and Stopping,” on page 37 tells you how to start and 
stop each of the product’s components.

Document Conventions
This document uses some stylistic and typographical conventions with which 
you might want to familiarize yourself.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:
70fr_ref_09-2004_v7.1.000.000 

You will need this number when you are talking with Genesys Technical 
Support about this product.

Type Styles

Italic

In this document, italic is used for the titles of documents, when a term is being 
defined, for emphasis, and for mathematical variables.

Examples
Please consult the Genesys 7 Migration Guide for more information.
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A customary and usual practice is one that is widely accepted and used 
within a particular industry or profession.
Do not use this value for this option.
The formula, x +1 = 7 where x stands for . . .

Monospace Font

A monospace font, which is shown in the following examples, is used for: 
• All programming identifiers and GUI elements. This convention includes 

the names of directories, files, folders, configuration objects, paths, scripts, 
dialog boxes, options, fields, text and list boxes, operational modes, all 
buttons including radio buttons, check boxes, commands, tabs, CTI events, 
and error messages; the values of options; logical arguments and command 
syntax; and code samples.
Examples

Select the Show variables on screen check box.
Click the Summation button.
In the Properties dialog box, enter the value for the host server in your 
environment.
In the Operand text box, enter your formula.
Click OK to exit the Properties dialog box.
The following table presents the complete set of error messages 
T-Server® distributes in EventError events.
If you select true for the inbound-bsns-calls option, all established 
inbound calls on a local agent are considered business calls.

• For any text the user must manually enter during a configuration or 
installation procedure: 
Example

Enter exit at the command line.

Information About Screen Captures Used in This 
Document

Screen captures taken from the product GUI (graphical user interface) and 
used in this document may sometimes contain a minor spelling, capitalization, 
or grammatical error. The text accompanying and explaining the screen 
captures corrects such errors except when such a correction would prevent you 
from installing, configuring, or successfully using the product. For example, if 
the name of an option contains a usage error, the name would be presented 
exactly as it appears in the product GUI; the error would not be corrected in 
any accompanying text.
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Use of Square Brackets

In any logical arguments, commands, and programming syntax presented in 
this document, square brackets are used to indicate that a particular parametric 
value is optional. That is, the value is not required to resolve a command, 
argument, or programming syntax. The customer/user decides whether to 
supply a value and what that value is. Here is a sample:
smcp_server -host [/flags]s

Use of Angle Brackets

Angle brackets are used to indicate that a value in a logical argument, 
command, or programming syntax is required, but that the user must supply 
the data for the value. Because the value is specific to an individual 
enterprise—for example, DNs or port numbers—the program cannot predict 
(that is, program in) what the value is. Here is a sample:
smcp_server -host <confighost>

Related Resources
Consult these additional resources as necessary: 
• Framework 7.1 Stat Server User’s Guide, which will help you understand 

statistics and how to configure them.
• The documentation for your Blue Pumpkin product.
• The Genesys Technical Publications Glossary, which ships on the Genesys 

Documentation Library CD and which provides a comprehensive list of the 
Genesys and CTI terminology and acronyms used in this document.

• The Release Notes and Product Advisories for this product, which are 
available on the Genesys Technical Support web site at 
http://www.genesyslab.com/support. 

Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 

• Genesys 7 Supported Operating Systems and Databases
• Genesys 7 Hardware Sizing Guide
• Genesys 7 Supported Media Interfaces 
Genesys product documentation is available on the:
• Genesys Technical Support web site at 

http://www.genesyslab.com/support. 
• Genesys Documentation Library CD, which you can order by e-mail from 

Genesys Order Management at orderman@genesyslab.com. 

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
http://genesyslab.com/support
http://genesyslab.com/support
mailto:orderman@genesyslab.com
http://genotype.genesyslab.com/library/retrieve/default.asp?item=B3BFC6DABE22B62AAE32A6D32753A0D1&view=item&fzip=False
http://genesyslab.com/support
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Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

mailto:techpubs.webadmin@genesyslab.com


10 Blue Pumpkin Integration 7.1

Chapter 1: About This Document Making Comments on This Document



Deployment Guide 11

Chapter

2 Overview of the Blue 
Pumpkin Integration
This chapter introduces the Blue Pumpkin Integration product, describes its 
architecture, and presents points you should consider when planning your 
deployment. This chapter contains these sections:

Overview, page 11
Architecture, page 14
Planning Your Deployment, page 16

Overview
The Blue Pumpkin Integration (BPI) enables you to gather real-time agent 
status and historical performance data from the Genesys Customer Interaction 
Management Platform and feed it to the Blue Pumpkin workforce management 
product. This enables you to access high-quality statistical data that the 
Genesys platform provides.
Integrating the Genesys Customer Interaction Management Platform with Blue 
Pumpkin workforce management offers the following benefits:
• Consistency between the historical statistics available through Genesys 

Reporting and those used in Blue Pumpkin for forecasting and scheduling.
• Accurate real-time agent status for display in the Blue Pumpkin Real-Time 

Agent Adherence module.
• Accurate data for Blue Pumpkin on Virtual Queue objects you have 

created in your Genesys environment. 
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Note: This Deployment Guide only covers the integration product itself. For 
more information on Stat Server and other Genesys components, see 
your Genesys documentation. For information on your Blue Pumpkin 
product, consult your Blue Pumpkin documentation.

BPI supplies two types of data:
• Historical statistics
• Real-time agent states

Historical Data
BPI records historical statistics every 15 minutes, on the quarter hour, in the 
form of a data file. 
This data file is placed in a user-configured directory, where Blue Pumpkin 
accesses it and converts the data into a form that Blue Pumpkin can use in 
forecasting, scheduling, and intraday reporting.
You can collect historical data on these statistics:
• Interaction Volume
• Average Speed of Answer (ASA)
• Service Level
• Abandons Volume
• Average Handling Time (AHT)
You can collect historical statistics about these types of objects:
• Groups of Agents
• Groups of Places
• Groups of Queues
• Route Points
• Queues

Note: Not all statistic types apply to all objects. For example, you collect 
abandonment statistics on a Queue or Route Point, rather than an Agent 
Group.

Real-Time Agent States
BPI sends updated real-time agent states every time the state changes. These 
status-change events include reason codes, if the underlying switch or soft 
phone supports them.
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Note: There is a 5-second delay in the transmission of real-time agent states. 
However, an accurate timestamp of each agent state change is included 
when the data is sent to Blue Pumpkin.

If you are using reason codes, you can configure the source of the reason-code 
data in the BPI section of the WFM Data Aggregator Application object’s 
Options tab. This ensures that BPI transmits the correct information.

Planning Objects
You use Planning Objects to link Genesys data from a specific Genesys object 
(for example, a Queue or Virtual Queue object) with a Blue Pumpkin Queue 
object. You create Planning objects in the Statistics Configuration Utility and 
associate them with Blue Pumpkin Queue objects using the Blue Pumpkin 
software. The exact identity of a Planning object depends on how routing is 
configured in your contact center. Depending on your routing structure, a 
Planning object might represent a specific call type or the call activity for an 
Agent Group (configured as a Virtual Queue object). 
For example, in a banking contact center, you might configure a Planning 
object called Mortgages, which is associated with a specific Genesys Queue or 
Virtual Queue object that is designated as the place where all calls about 
mortgages are directed. In this case, Stat Server monitors this Mortgage Queue 
object (or Virtual Queue object) and collects the statistics you configured for 
the associated Planning object using the Statistics Configuration Utility. Stat 
Server sends this statistical data to WFM Data Aggregator, which aggregates 
them and writes them to a BPI-format file that Blue Pumpkin can read. 
In Blue Pumpkin, this Planning object is associated with a Blue Pumpkin Queue 
object, which may also be called Mortgages. The Blue Pumpkin Mortgages 
Queue object is used to forecast the staffing required to handle the Mortgage 
calls, to schedule the appropriate personnel to handle those calls, and to 
monitor how closely actual performance matches the plan, during the day and 
over time. The Blue Pumpkin software uses the data that the Genesys CIM 
Platform collects as the basis for forecasting, scheduling, and performance-
monitoring.

Note: Planning object names must not include commas. 
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Architecture
BPI consists of:
• Genesys WFM Configuration Wizards.
• Genesys WFM Data Aggregator, which translates statistical information it 

receives from Stat Server into a form that your workforce management 
program can use.

• Statistics Configuration Utility, which enables you to configure the 
combination of Genesys objects (Queues, Virtual Queues, Agent Groups, 
and so on) and Genesys statistics that are mapped to Blue Pumpkin Queue 
objects.

Note: BPI does not require any external databases except the Genesys 
Configuration Database.

Figure 1 shows how the BPI components interact with the Genesys CIM 
Platform and Blue Pumpkin. 

Figure 1: Blue Pumpkin Integration Architecture

T-Server

Stat Server

Blue Pumpkin
Exchange

Server

Configuration
Server

Data
Aggregator

Statistics
Configuration

Utility

Deployment
Wizards

Real-Time Agent States

Historical
Data Blue Pumpkin

displays and
reports

Genesys

Blue Pumpkin
TCP/IP



Deployment Guide 15

Chapter 2: Overview of the Blue Pumpkin Integration Architecture

Historical Statistics Data Flow
As interactions are processed in your contact center, Stat Server captures data 
about them that it compiles in the form of statistics. Which statistics Stat 
Server generates depends on which you have configured as you set up Stat 
Server and the various Genesys products it serves. 

Note: BPI supports a primary and backup Genesys Stat Server, and a primary 
and backup Genesys Configuration Server.

Stat Server sends statistical data to Data Aggregator, which processes the 
information and tailors the data to present contact-center performance 
information that your workforce management application can use.
BPI sends this data in the form of .bpi files, a proprietary Blue Pumpkin 
format, to the Blue Pumpkin Exchange Server. .bpi files are Blue Pumpkin’s 
standard for describing contact-center statistical data. 
• These data files consist of one data row per Planning object in each 15-

minute update.
• You can specify the host name and the path to the location in which 

Genesys places the historical data file.
After the data arrives at the Blue Pumpkin Exchange Server, Blue Pumpkin 
handles the data according to its own protocols.

Real-Time Agent State Data Flow
Stat Server sends real-time agent state events to Data Aggregator, which 
formats the agent state events into messages that are appropriate for Blue 
Pumpkin. Data Aggregator sends these agent state change messages to Blue 
Pumpkin over TCP/IP. Real-time agent state data is updated every time there is 
an agent-state change event.
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Planning Your Deployment
When you are planning your deployment, among other things, you must 
consider:
• Software and hardware requirements.
• The historical statistics you want to collect.
• The objects for which you want to collect historical statistics.
• The Genesys Agent Group for which you want real-time status data.
Planning your statistics configuration is a critical part of deployment planning.
• For information about the statistics you can collect and for which objects 

you can collect them, see “Historical Statistics” on page 17. 
• For detailed information on how to configure statistics, see Blue Pumpkin 

Integration 7.1 Statistics Configuration Utility Help.
Answer the following questions as part of your predeployment analysis. 
1. Do you have supported versions of Genesys Framework and Blue 

Pumpkin? The Blue Pumpkin version can be:
Version 4.5
Version 3.3

Note: Blue Pumpkin 4.5 or higher is required to display reason codes in 
the Blue Pumpkin Real-Time Adherence module.

You can use:
Framework 6.5.1, 7.0, or 7.1

BPI supports these operating systems
Servers—Windows 2000 Server, Windows Server 2003
Clients—Windows 2000 Professional, Windows XP SP2, Windows 
2000 Server, Windows Server 2003 

Client workstations must have installed:
Microsoft .NET 1.1 or later 

The computer on which WFM Data Aggregator is installed must have:
MDAC 2.7 SP1 or later

2. Do you know what objects, such as Genesys Virtual Queues, you intend to 
monitor?

3. Do you know what kind of information you want to obtain about each 
object?

4. Have you configured the statistics you need in Stat Server? When you run 
the Genesys WFM Wizards that create your BPI solution, you can choose 
to automatically add the recommended statistics to your Stat Server. 
Genesys recommends that you do so. See Table 1 for these statistics.
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If you need instructions for checking your Stat Server statistics and 
manually configuring new ones, see the Framework 7 Stat Server User’s 
Guide or the Framework 7.1 Stat Server User’s Guide.

Historical Statistics
This table contains only a basic list of statistics. Full configuration information 
is available in Blue Pumpkin Integration 7.1 Statistics Configuration Utility 
Help, which you can access from the Statistics Configuration Utility or the 
Genesys Technical Support website. 

Table 1: BPI Historical Statistics

Statistic Type Statistics Options Available 
Objects

Interaction Volume TotalNumberCallsEntered 
(WFMTotalNumberCallsEntered)

Queue, Route 
Point, Group of 
Queues

Service Level ServiceFactor1 
(WFMServiceFactor1)

Queue, Route 
Point, Group of 
Queues

Abandons TotalNumberCallsAband 
(WFMTotalNumberCallsAband)

Queue, Route 
Point, Group of 
Queues

Average Speed of 
Answer

AverTimeBeforeAnswering 
(WFMAverTimeBeforeAnswering)

Queue, Group of 
Queues

Average Handling 
Time

AverHandleDNStatusTime 
(BPIAverHandleDNStatusTime)

Group of Agents, 
Group of Places
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3 Configuration and 
Installation
This chapter explains how to use the Genesys Workforce Management (WFM) 
Configuration Wizards to configure the Blue Pumpkin Integration (BPI) 
product and how to install the required components. This chapter has these 
sections:

Overview, page 19
Preliminary Preparation, page 20
Import the Application Templates, page 20
Install the Configuration Wizards, page 21
Run the Configuration Wizards, page 22
Install the Components, page 25
Configure Application Objects Manually, page 26

Overview
To deploy BPI, you must:
• Import the BPI Application templates into Configuration Manager.
• Run the Configuration Wizards, which enable you to configure the WFM 

Data Aggregator and Statistics Configuration Utility Application 
objects.

Note: The Statistics Configuration Utility uses the WFM Client 
Application object.

• Install the software, which is located on the Blue Pumpkin Integration CD-
ROM.
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• Start all components and test their performance. You will find starting and 
stopping instructions in Chapter 4 on page 37.

Preliminary Preparation
BPI 7.1 works in conjunction with a number of software components. Before 
installing BPI, you must have set up Genesys Framework. The Framework 
installation should include at least the following components:
• Configuration Manager 
• Configuration Server
• DB Server
• T-Server 
• Stat Server 

Note: BPI 7.1 is compatible with Genesys Framework 7.x and 6.5.1. 
However, for full interoperability with BPI 7.1—for example, to take 
advantage of the most complete reason-code support and for the ability 
to start and stop the BPI Solution through the Genesys Management 
Layer—use Genesys Framework version 7.0 or higher. 

Genesys Agent Group Configuration

Before configuring and installing BPI, you must set up an Agent Group using 
Configuration Manager. All agents for whom you want Genesys to collect real-
time status information to be sent to Blue Pumpkin must be members of this 
Agent Group. You can specify this Agent Group in the BPI section of the WFM 
Data Aggregator Application object’s Options tab or set it on the main 
window of the Statistics Configuration Utility.

Note: An agent may be configured in the Genesys Configuration Database to 
belong to more than one Agent Group. However, you can only use one 
Agent Group for BPI.

Import the Application Templates
To import application templates:
1. In Configuration Manager, select Environment > Application Templates.
2. Right-click Application Templates and select Import Application 

Template from the shortcut menu.
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A dialog box opens that enables you to browse to the application templates 
on your BPI 7.1 CD. 

3. Select a template and then click Open. These are the template names:
WFM_Client_710.apd (used for the Statistics Configuration Utility)
WFM_Data_Aggregator_710.apd

4. Enter a name for the template in the Name text box on the General tab, if 
desired.

Note: Do not make any other changes to the template. When you create 
Application objects using the imported templates, you configure them 
as explained in the following sections.

5. Click OK to save the template.
6. Repeat steps 1–4 to import the other application template. 
After you have imported the application templates, you can configure new 
Application objects based on them, as described in the various sections that 
follow.

Import the BPI Solution Template
1. In Configuration Manager, select Environment > Solutions.
2. Right-click Solutions and select Import Solution Template from the 

shortcut menu.
A dialog box opens that enables you to browse to the solution template on 
your BPI 7 CD. 

3. Select the template and then click Open. The template name is 
BPI_Solution_710.sd.

4. Enter a name for the template in the Name text box on the General tab, if 
desired.

Note: Do not make any other changes to the template. When you run the 
Genesys WFM Configuration Wizards, they configure the solution for 
you.

5. Click OK to save the template.

Install the Configuration Wizards
The Genesys WFM Wizards guide you through the process of creating the 
Application objects for the BPI components. They are run from the Genesys 
Wizard Manager.
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You can also create and configure the component Application objects 
manually. For instructions, see “Configure Application Objects Manually” on 
page 26.
The procedure given in this section assumes that you have already installed the 
Genesys Wizard Manager. If not, you must do so before you can install the 
Genesys WFM Configuration Wizards. For instructions, see the Framework 
7.1 Deployment Guide.
You must install the Genesys WFM Configuration Wizards before you can run 
them. To do so:
1. Navigate to the configuration_wizards directory on the BPI CD.
2. Double-click Setup.exe.

The Genesys WFM Configuration Wizards 7.1 Setup begins.
3. Click Next in the Welcome window to start the installation process.
The setup process for the WFM Configuration Wizards locates the directory in 
which you have installed the Genesys Wizard Manager. You must install the 
WFM Configuration Wizards in the same directory. 
4. Click Next to continue.

A progress bar appears as the Wizard files are copied.
5. Click Finish to exit the setup process after all files have been copied.

Run the Configuration Wizards
1. Select Start > Programs > Genesys Solutions > Genesys Wizard Manager 

from the Windows taskbar.
2. Enter the login information for your Configuration Server in the LogIn 

screen that opens.
3. From the list of solutions at the left side of the Set Up Your Solutions 

screen, click Workforce Management.
4. Click the Deploy Workforce Management link that appears on the right-hand 

pane of the Set Up Your Solutions screen.
The Genesys WFM Wizard Welcome screen opens. 

5. Select the Genesys Blue Pumpkin Integration radio button and then click 
Next.
The Welcome screen for the Genesys Blue Pumpkin Integration Wizard 
opens. 

6. Click Next to continue.
The General screen opens.
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7. Enter a name for your BPI solution and select a Solution Control Server. 
Management Layer uses this Solution Control Server to start, stop, and 
monitor WFM Data Aggregator.

8. Click Next.

Configuring WFM Data Aggregator
The Genesys WFM Wizard now looks for a WFM Data Aggregator Application 
object. If you have already created a one, it is listed in the WFM Data 
Aggregator screen. 
1. At this point:

Select an already created Application object and click Next to proceed 
to the next wizard.
Select an already created Application object and then click Properties 
to edit it before proceeding.
Click Add to create a new Application object.
Clicking the Add button opens the Browse for Application (WFM Data 
Aggregator) screen, which shows the contents of your Configuration 
Manager Applications folder. 

2. To create your WFM Data Aggregator Application object, click the New 
Application icon. It is the left-most icon at the top of the screen and looks 
like a piece of blank paper with a folded corner.
The WFM Data Aggregator Wizard opens.

The WFM Data Aggregator Wizard

This Wizard opens with a Welcome screen. 
1. Click Next to proceed.
2. Enter a name for your WFM Data Aggregator Application object and then 

click Next.
3. Select the host name of the computer on which you want to install this 

application.
This is the computer where WFM Data Aggregator will be installed, not 
the host for the Configuration Server computer.
Click Next to continue.

4. On the Connections screen, select from the drop-down list or browse to 
your Stat Server Application object. 

5. Click Add WFM Statistics to have the Wizard add preconfigured WFM-
specific statistics to your Stat Server. Then click Next to continue.
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Note: For a description of these statistics and instructions for configuring 
them to gather information about the objects in you environment, 
see the Blue Pumpkin Integration 7.1 Statistics Configuration 
Utility Help.

6. On the Options for Blue Pumpkin Integration screen, enter the full path 
to the location where you want the historical data files to be placed. Then 
enter the port number on which the Blue Pumpkin Exchange Server will 
listen for real-time agent status change events
The default port number is 12000.

7. Click Next to open the Log Configuration screen. You can click Run Log 
Wizard to customize your log settings or click Next to accept the default log 
settings. 

Note: The default setting, all, is recommended for testing, not for a 
production environment. 
You can change the log settings at any time by using the Wizard to edit 
your WFM Data Aggregator Application object or by editing the Log 
section on the Options tab of the WFM Data Aggregator Application 
object. 
Procedures for editing Options tab settings are described in “Configure 
Application Objects Manually” on page 26

8. Click Finish to close the WFM Data Aggregator Wizard. The Browse for 
Applications (WFM Data Aggregator) screen reopens, showing your new 
WFM Data Aggregator Application object. 

9. Select your new WFM Data Aggregator Application object and click OK.
The new Application object now appears in the Solution Components list. 

10. Click Next to continue.

Configure the Statistics Configuration Utility Application 
Object

You configure the Application object for the Statistics Configuration Utility 
based on the WFM Client Application template. To create the Statistics 
Configuration Utility Application object:
1. Start at the Genesys WFM Wizard’s WFM Client screen. Click New.
2. Click Next to begin using the WFM Application Wizard.
3. Enter a name for your Statistics Configuration Utility Application 

object and then click Next.
4. Click Finish to close the WFM Application Wizard. 
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The new Application object appears in the Application List.
5. Select your new Statistics Configuration Utility Application object 

and then click OK.
The Completing the WFM Solution Wizard screen opens.

6. Click Finish to close the Genesys WFM Configuration Wizards.
Your new BPI solution appears under Currently Installed Solutions on 
the Genesys Wizard Manager’s Workforce Management pane.

Install the Components
This installable components of the Blue Pumpkin Integration are WFM Data 
Aggregator and the Statistics Configuration Utility.
To run BPI, you must also set up your Blue Pumpkin Exchange Server to 
receive the data that the Genesys Framework and BPI collect. This document 
covers only BPI itself. It does not explain how to configure the Blue Pumpkin 
Exchange Server to receive the data.

Install WFM Data Aggregator
1. Verify that the Genesys Configuration Server and DB Server are started.
2. Navigate to the solution_specific\WFMDataAggregator\windows directory 

on your BPI CD.
3. Double-click Setup.exe. This opens the WFM Data Aggregator Installation 

Wizard.
4. Click Next to begin using the Wizard.
5. Enter this information for your Configuration Server: host name, port 

number, user name, and password. Then click Next.
A list of WFM Data Aggregator Application objects appears. 

6. Select the object that you created for BPI and then click Next.
7. Specify the destination directory where you want WFM Data Aggregator 

to be installed. Then click Next.
8. On the Ready to Install screen, click Install.

A progress bar shows the setup status.
9. Click Finish to close the Installation Wizard.

Install Blue Pumpkin Integration
1. Verify that the Genesys Configuration Server and DB Server are started.
2. Navigate to the solution_specific\BPI\windows directory on your BPI CD.
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3. Double-click Setup.exe. This opens the Blue Pumpkin Integration (BPI) 
Installation Wizard.

4. Click Next to begin using the Wizard.
5. Enter this information for your Configuration Server: host name, port 

number, user name, and password. Then click Next.
A list of Data Aggregator Application objects appears. 

6. Select the same object that you selected during the Data Aggregator 
installation. Then click Next.

7. On the Ready to Install screen, click Install.
A progress bar shows the setup status.

8. Click Finish to close the Installation Wizard.

Install the Statistics Configuration Utility
1. Navigate to the solution_specific\WFMConfigurationUtility\windows 

directory on your BPI CD.
2. Double-click Setup.exe. This opens the Statistics Configuration Utility 

Installation Wizard.
3. Click Next to begin using the Wizard.
4. Specify the destination directory where you want the Statistics 

Configuration Utility to be installed. Then click Next.
5. On the Ready to Install screen, click Install.

A progress bar shows the setup status.
6. Click Finish to close the Installation Wizard.

Configure Application Objects Manually
Although the Configuration Wizards do the configuration required to deploy 
BPI, you may need to manually change some settings after the initial 
deployment. Or you may prefer to do the entire configuration manually.
To edit settings:
1. In Configuration Manager, open the Environment > Applications folder.
2. Open the Application object you want to edit. 
3. Make your changes. For recommended settings for all tabs except the 

Options tab, see “Configuring WFM Data Aggregator” on page 23 and 
“Configure the Statistics Configuration Utility Application Object” on 
page 24. For descriptions of the Options tab options and their 
recommended settings, see “Options Tab Settings for WFM Data 
Aggregator” on page 28. 
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Note: There are no Option tab options to set in the Statistics Configuration 
Utility Application object.

To configure the Application objects manually:
1. In Configuration Manager, open the Environment > Applications folder.
2. Right-click in the folder and select New Application from the shortcut 

menu that appears.
3. Browse to and select the appropriate application template from those you 

previously imported. If necessary, see “Import the Application Templates” 
on page 20 for instructions.

4. Enter the appropriate information in each tab of the Application object. If 
you need guidance, check the description of how to configure that 
component in “Run the Configuration Wizards” on page 22. For a list of 
the Options tab options, with default settings and descriptions, see 
“Options Tab Settings for WFM Data Aggregator” on page 28.

Manually Create the BPI Solution Object
If you are using Management Layer, you must use the Genesys WFM 
Configuration Wizards to create the BPI Solution object and add the necessary 
components. If you have not yet imported the solution template, see “Import 
the BPI Solution Template” on page 21.
To configure the Solution object:
1. Double-click the BPI Solution template you imported to open its 

Properties dialog box.
2. On the Components tab, add the servers that BPI needs to run (see Table 2 

on page 28).

Note: The Components Definition tab displays the preset component 
types that the solution connects with. The actual connections are 
configured on the Components tab, but you can use the Components 
Definition tab as a guide to correct settings.

Application is the name of the application that the BPI Solution object 
runs.
Optional is the requirement status. False means that the application 
must run successfully for BPI to run. True means that the application is 
optional for BPI to run.
Startup Priority is the order in which to start the servers.

Note: You cannot revise Startup Priority after you have configured it.
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3. Click OK.

Options Tab Settings for WFM Data Aggregator 
From the Options tab you can modify the default WFM Data Aggregator 
configuration settings. The tab contains five sections. The options in each of 
these sections are described in the following pages.

Client Section

CfgServerRequestTimeout
Type: Mandatory
Default Value: 10 seconds
Valid Values: Any positive integer
Dependencies: None
The BPI configuration synchronization timeout.

SOAPTimeout
Type: Not applicable
Default Value: 90 seconds
Valid Value: Any positive integer
Dependencies: None
Not used.

Identity Section

ApplicationType
Type: Optional
Default Value: WFMDataAggregator
Valid Value: WFMDataAggregator
Dependencies: None
Used only if you are running Framework 6.x. If so, you must specify 
ThirdPartyServer as the application type in the WFM Data Aggregator 
Application object and use this option to notify Configuration Server that the 
Application object is for WFM Data Aggregator.

Table 2: Definitions Tab Settings for the BPI Solution 
Components

Application Optional Startup Priority

WFM Data Aggregator False 2

Stat Server False 1
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Log Section

verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None
Filters output of log messages based on their assigned priority. All enables 
output of all messages to the log file. Trace enables informational and error 
messages and disables debug messages. Standard enables error messages only 
and disables informational and debug messages. None disables all messages.

buffering
Type: Mandatory
Default Value: no
Valid Values: yes, no
Dependencies: None
Turns system file buffering on or off.

segment
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None
Sets the maximum size (in KB, MB, or hours) of the log file segment, after 
which a new segment is created. The default size is in KB. The value cannot be 
less than 100 KB or less than one hour. No indicates no segmentation of the log 
file.

expire
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number> file, <number> day
Dependencies: None
Sets the expiration mode for old segments. The number of files to be stored 
cannot be less than 1 file or 1 day or more than 100 files or 100 days. No 
indicates that files do not expire.

messagefile
Type: Mandatory
Default Value: wfmdataaggreagtor.lms
Valid Value: Any character string
Dependencies: None
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Sets the name of the file that stores application-specific log messages. 

multithreaded
Type: Mandatory
Default Value: no
Valid Values: yes, no
Dependencies: None
Sets whether the logging subsystem creates a special logging thread to process 
log messages. This option is available only for a multithread-enabled log 
library.

standard
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, 
<filename>

Dependencies: None
Specifies that log events of the Standard level are to be sent to the listed 
outputs. For centralized logging, use network. You can use a local file name or 
stdout as well as network.

trace
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, 
<filename>

Dependencies: None
Specifies that log events of the Trace level are to be sent to the listed outputs. 
For centralized logging, use network. You can use a local file name or stdout 
as well as network.

debug
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, 
<filename>

Dependencies: None
Specifies that log events of the Debug level are to be sent to the listed outputs. 
Do not use network unless Genesys Professional Services directs you to do so 
because that setting generates extremely heavy message loads that can degrade 
system performance.

all
Type: Mandatory
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Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, 
<filename>

Dependencies: None
Specifies that log events of all levels, Standard, Trace, and Debug, are to be 
sent to the listed outputs. Do not use network unless Genesys Professional 
Services directs you to do so because that setting generates extremely heavy 
message loads that can degrade system performance.

x-LogAgentEventTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None
Indicates whether WFM Data Aggregator should write agent event data to a 
log file. Used for debugging only.

x-LogConfigServerConnectionTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None
Indicates whether WFM Data Aggregator should write Configuration Server 
connection data to a log file. Used for debugging only.

x-LogConfigServerTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None
Indicates whether WFM Data Aggregator should write Configuration Server 
process data to a log file. Used for debugging only.

x-LogSynchronizationTrace
Type: Not applicable
Default Value: No default value
Valid Values: yes, no
Dependencies: None
Not used.

x-LogWFMServerTrace
Type: Not applicable
Default Value: No default value
Valid Values: yes, no
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Dependencies: None
Not used.

Options Section

DBDumpFile
Type: Not applicable
Default Value: No default value
Valid Value: Any valid file name
Dependencies: None
Not used.

HandleTimeWriteBack
Type: Not applicable
Default Value: No default value
Valid Value: 1-12
Dependencies: None
Not used.

PrimaryServer
Type: Mandatory if you are using a backup server; otherwise optional
Default Value: No default value
Valid Value: The primary Data Aggregator application name
Dependencies: Only configured when setting up a backup Data Aggregator 
server
Indicates the name of the primary Data Aggregator that this backup is 
supporting. 

ReasonCodeKeyName
Type: Optional
Default Value: No default value
Valid Values: ExtensionReasonCode, ReasonCode
Dependencies: None
Specifies the reason (aux)-code key used in the enterprise. You do not need to 
configure this option if you do not use reason codes.
WFM Data Aggregator can process reason codes that come from hard and/or 
soft phones. For WFM Data Aggregator to receive reason codes from hard 
phones, set this option to ExtensionReasonCode. In a mixed hard/soft phone 
environment, set this option to ReasonCode.
You can only use reason codes from hard phones if you are using Stat Server 
7.x.
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ReasonCodeWaitTime
Type: Not applicable
Default Value: 15
Valid Value: 2–600
Dependencies: None
Not used.

ScheduleLookAheadMinutes
Type: Not applicable
Default Value: No default value
Valid Value: 0-1440
Dependencies: None
Not used.

SynchronizeUnassignedAgents
Type: Not applicable
Default Value: No default value
Valid Value: yes, no
Dependencies: None
Not used.

BPI Section

If you did not use the WFM Configuration Wizards to set up WFM Data 
Aggregator, this section does not appear. You must create this section, using 
the exact name BPI, and then create and set values for the options it should 
contain. 

Note: You do not need to configure the TimeValueFormat or MaxFileSize 
options. They are not used in BPI 7.1.

To create the BPI section:
1. On the Options tab, right-click in an empty spot.
2. Select New.

A new section appears.
3. Enter BPI as the section name.
To create the settings in the section:
1. Right-click in an empty spot in the BPI section pane.
2. Select New.
3. Enter an option name and value for the new setting. 

Read the descriptions below to determine the settings to enter.
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4. After entering the values, click OK.
5. Repeat Steps 1–4 until you have configured all the options.

AgentGroupName
Type: Mandatory
Default Value: No default value
Valid Value: Any valid agent group name
Dependencies: None
Specifies the Configuration Manager Agent Group for which this WFM Data 
Aggregator should send real-time agent states.

TenantName
Type: Mandatory
Default Value: No default value
Valid Value: Any valid tenant name, Resources
Dependencies: None
Indicates the tenant to which the specified Agent Group belongs. In a single-
tenant environment, use Resources.

TenantPassword
Type: Mandatory
Default Value: No default value
Valid Value: The password configured for the specified tenant.
Dependencies: TenantName
Identifies the password for the tenant specified in the TenantName option.

TimeProfile
Type: Optional
Default Value: No default value
Valid Value: Any time profile that has been configured in Stat Server.
Dependencies: None
Sets the time profile that is to be used for any statistics WFM Data Aggregator 
gathers that require a time profile. You can set this value in the Statistics 
Configuration Utility or here.

MaxFileSize
Type: Not applicable
Default Value: 1024
Valid Value: 
Dependencies: None
Not used.
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TimeValueFormat
Type: Not applicable
Default Value: S
Valid Values: comma, semicolon, tab
Dependencies: None
Not used.

Port
Type: Mandatory
Default Value: 12000
Valid Value: Any valid port number
Dependencies: None
Specifies the port number over which Genesys sends the real-time agent state 
changes to the Blue Pumpkin Exchange Server. You initially configure this 
value using the Genesys WFM Configuration Wizards. You can change the 
port number at any time by entering a different value here.

FileName
Type: Mandatory
Default Value: No default value
Valid Value: Any valid path and file name
Dependencies: None
This option specifies the name of the historical data file and the location where 
BPI should place it. This value is set during configuration using the WFM 
Configuration Wizards. If you did not use the WFM Configuration Wizards to 
set up WFM Data Aggregator, there is no value set for this option and the 
historical file is written to the same directory as the WFM Data Aggregator 
executable. 
You can use either of these formats to specify the historical file location:

Using a drive letter: <drive>:\<directory>
Using UNC format: <\\host>\<directory>

Relative paths are not supported.
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4 Starting and Stopping
You can start and stop the BPI servers—that is, WFM Data Aggregator and 
Stat Server—using Management Layer or you can start and stop all 
components manually. 
You must start the Statistics Configuration Utility manually even when you are 
using Management Layer.

Note: This chapter does not provide instructions for starting and stopping the 
Genesys Framework components or the Blue Pumpkin components. 
For this information, see Framework 7.1 Deployment Guide and your 
Blue Pumpkin documentation.

This chapter contains these sections:
Overview, page 37
Start and Stop BPI with SCI, page 38
Start and Stop the Servers, page 39
Start and Stop the Statistics Configuration Utility, page 41

Overview
These starting and stopping instructions cover a number of methods you might 
use to start and stop WFM Data Aggregator, Stat Server, and the Statistics 
Configuration Utility. Select the methods that are best suited to your 
environment.

Note: When starting BPI, confirm that the servers are running before you 
start the Statistics Configuration Utility.
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Start and Stop BPI with SCI
To start BPI from SCI:
1. Start the SCI.
2. Go to the Solutions view.
3. Right-click the desired solution and select Start from the shortcut menu.

-or-
Select the desired solution and choose Action > Start on the menu bar.

The command to start BPI is sent to Solution Control Server (SCS), which uses 
Local Control Agents to activate the BPI solution components in the order 
established during solution configuration. SCI reports a successful start of BPI 
after both the Stat Server and WFM Data Aggregator associated with BPI 
display Running status within the configured timeout. When both servers are 
started, the solution status changes from Stopped to Started.

Note: Because a number of solutions may share a Stat Server, your Stat 
Server may display Running status before you start BPI.

To stop BPI from SCI:
1. Start SCI.
2. Go to the Solutions view.
3. Right-click the desired solution and select Stop from the shortcut menu.

or
Select the desired solution and choose Action > Stop on the menu bar.

The command to stop BPI is sent to Solution Control Server, which uses Local 
Control Agents to shut down the BPI servers in the order established during 
solution configuration. When both servers are stopped, the solution status 
changes from Started to Stopped.

Note: Because a number of solutions may share a Stat Server, Stat Server 
may display Running status after BPI is stopped.

For more information on SCI, see Framework 7.1 Solution Control Interface 
Help. To view Help, open SCI, and click Help. For more information on 
Management Layer topics, see the Framework 7.1 Management Layer User’s 
Guide.
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Start and Stop the Servers
There are several ways to start the BPI servers (WFM Data Aggregator and 
Stat Server). 
By default, all Genesys servers are installed as Windows Services. The 
Services are configured to start when the computer starts.
You may configure the Services to start manually instead of automatically or 
remove them from Services.

Configure the Windows Services
To configure the Windows Services to start manually rather than 
automatically:
1. From the Windows taskbar, select Start > Programs > Settings > 

Control Panel > Services.

The Services window appears. Each Service has status settings showing 
whether it starts manually or automatically and whether it is currently 
running.

2. Highlight the service you want to configure and then click Startup.
3. Select manual.
4. Click OK. In the Services window, click Close.

The settings are saved.

Manually Start a Windows Service
If you have configured a Windows Service to start automatically, it starts 
whenever you start the computer. No further action is required. 
If you have configured a Windows Service to start manually:
1. From the Windows taskbar, select Start > Programs > Settings > 

Control Panel > Services.

The Services window appears.
2. Highlight the Service to start.
3. Click Start.

Start the BPI Servers Manually
1. From the Windows taskbar, select Start > Programs > Genesys 

Solutions > BPI > <server name>.

The server console window opens and the server begins its initialization 
routine.
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2. If desired, right-click the console window’s title bar to change server 
display settings. 

3. Minimize the window after the server has started.

Stop the BPI Servers
You can stop the BPI servers in several ways depending on whether the servers 
are installed as Windows Services.

Warning! If you terminate a server using the Windows Task Manager, you 
will lose all data on currently active interactions because Windows 
does not allow enough time for the servers to save the active data. 

Stop the Servers Manually
The method for stopping a server manually depends on whether it is running as 
a Windows Service.
If the server is running in a console window rather than as a Service, shut it 
down using the following method:
◆ Enter [Ctrl+Break] or [Ctrl+C].

Note: You cannot close a server by clicking the Close button (X) or selecting 
File > Close from the console window menu bar. This restriction 
prevents abnormal shutdown and data loss.

You can also stop a server’s Windows Service from a command prompt:
1. From the Windows taskbar, select Start > Programs > Command Prompt.
2. Change to the directory in which the server’s .exe file is located.
3. At the prompt, enter <servername>.exe -sstop.

Stop a Server’s Windows Service
To stop a Service from the Services window:
1. From the Windows taskbar, Start > Programs > Settings > Control 

Panel > Services in Windows and select the appropriate Service.
2. Click Stop.
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Start and Stop the Statistics 
Configuration Utility

1. First, verify that the BPI servers are running. 
2. From the Windows taskbar, select Start > Programs > Genesys 

Solutions > BPI > Statistics Configuration Utility.

The Login dialog box appears.
3. Enter your user name and password.
4. If this is the first time you are opening the Statistics Configuration Utility, 

click Details. Then enter the Configuration Server host name and port 
number and the name of the Statistics Configuration Utility 
Application object that you configured using the Genesys WFM 
Configuration Wizards.

Note: Click Help or press F1 in any Statistics Configuration Utility window to 
open Blue Pumpkin Integration 7.1 Statistics Configuration Utility 
Help.

Stop the Statistics Configuration Utility
◆ Select File > Exit from the menu.
or
◆ Click the X button in the upper-right corner of the application window.
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